
 The Villages Computer Club  

The Villages Computer Club will meet at 1 p.m. Friday June 28 st at Lake Miona Recreation 

Center.  

 The program will feature a presentation on "Protecting and Backing Up Your Data" by Bob 

Walton. 

 This is something to think about now while your data is accessible. Don't wait until you have a 

problem and can't get to your data.  

 Following the presentation will be refreshments, door prizes and a problem solving session. 

 If you have a computer problem you can't resolve, fill out the troubleshooting request form 

found at thevillagescomputerclub.com  and bring it to the meeting. Forms are also available at 

the meeting.  Ask for one when you pick up your door prize ticket. 

 Guests are always welcome, please bring your village ID card. For information or to sign up to 

be on the VCC email list, visit the website or email Paul Rabenold at TVCC.Pres@gmail.com 

 thevillagescomputerclub.com 

**************************************************************************************  

Pictures to Picasa 
 
Q. How can I move pictures sent to me as attached files into my Picaso2 folder? 
  
Answer 
1.Save the  photo's you downloaded from email into a folder (not Picasa’s folder). 
I recommend you create  sub-folders in your My Pictures folder in order to make 
it easy to find certain pictures. (Remember Picasa does not copy your pictures to 
the Picasa program.  It merely indexes the pictures it finds on your computer to 
make it easy for you to find them while working in Picasa. 
    a. Rightclick Start...Explore. 
    b. Click the My Documents folder and scroll down to the My Pictures folder. 
    c. Click once on My Pictures folder to select it, then click File...New...Folder.  
Give the folder a name. Click Enter twice. 
    d. Now, locate the downloaded photos and drag and drop them into this 
subfolder of My Pictures that you created. (You may create many subfolders in 
order to organize pictures further into such things a Vacation 2008, Vac 2010, 
Marys Family,etc. 
2. Now, you need to tell Picasa where to look for your pictures..  
    a. Start Picasa and click on the Tools tab. Then click on Folder Manager. 
    b. In the Folder Manage box, click on the folder or folders you want Picasa to 
scan to find new pictures you have added. 
    c. Once you select the folder, check the box with the icon that looks like an Eye 
and is labeled "scan always".  



If you created your folder in step 1 under the My Pictures folder, then all you need 
to do is make sure that Picasa is set to scan the My Pictures Folder. This will 
cause it to scan all the folders under my pictures every time you start Picasa or 
add new pictures while Picasa is running. 
  
Note:   Picasa doesn't actually move pictures, files and/or folders, it simply 
creates an index file so it knows where your pictures are located. It then displays 
them and lets you work with them in that folder. I know it "looks" like the pictures 
have been moved into Picasa, but they haven't. 
 
Note: Warning!!!  If you DELETE a picture from Picasa, it will be deleted from the 
folder where it is stored….the My Pictures folder or other folder that is used to 
store Pictures. 
**************************************************************** 

Picasa3 
 

Click here: Picasa 3: Free download from Google 
 
Note: below is a link to a web page that has a "Forum"-type exchange regarding a 

user's loss of photos uploaded to Picasa - because he was not aware of how the 

Program works.  This link will help you to understand what Picasa does and 
does NOT do. 
   
http://www.google.com/support/forum/p/Picasa/thread?tid=385f541f5231b5d1&hl=e

n 
 
 
Together, Picasa & Picasa Web Albums make it easy to organize, edit and share your photos. 
 

1.     When you launch Picasa, you can immediately organize and edit the photos on 
your hard drive. Picasa can also help import pictures from your camera. 

2.     Try sharing pictures online with Picasa Web Albums. To get started, simply 
select photos that you'd like to share, and press the 'Upload' button. 

3.     Try adding name tags to your photos on Picasa or Picasa Web Albums. Click 
"Unnamed People" in Picasa to get started. 

 

 

 

Click here: Getting Started Guide - Picasa Help 
 

• Two things to know  
• Add your photos  
• Organize your photos  
• Edit your photos  
• Share your photos  



• Discover more features  

Two things to know  

The Picasa software provides a simple way to view, edit, and organize the photos on your 
computer. As you get started, there are two things you should always remember: 

• Picasa does not store the photos on your computer. 
When you open Picasa, it simply looks at the folders on your computer and displays the 
photos it finds. It displays the file types that you tell it to find, in the folders that you tell it 
to search.  

• Your original photos are always preserved. 
When using editing tools in Picasa, your original files are never touched. The photo edits 
you make are only viewable in Picasa until you decide to save your changes. Even then, 
Picasa creates a new version of the photo with your edits applied, leaving the original file 
totally preserved.  

Add photos to Picasa 

Use Picasa to view photos already on your computer, or to import photos from your camera. 

Add photos already on your computer 

Once you've downloaded and installed Picasa, you have total control over the photos that Picasa 
displays. Picasa shows you the photo and video file types that you tell it to find, in the folders that 

you tell it to search.  

Organize your photos 

The folder list on the left is the hub for Picasa organization. By scrolling through this list, you can 
access all photos displayed by Picasa. To understand Picasa organization, you need to 
understand the following three collections: 

• Folders 
Folders in Picasa represent the folders on your computer. You control the folders that are 
scanned and displayed by Picasa. Changes you make to folders in Picasa affect the 
corresponding folders on your computer's hard drive. For example, if you delete a photo 
in a Picasa folder, that photo is also deleted from the computer.  

• Albums 
Unlike folders, albums exist only in Picasa. Albums allow you to create virtual groups of 
photos taken from multiple folders on your computer. Albums display those photos 
without actually moving the photo -- it's like a playlist for photos. When you delete or 
move photos from an album, the original files remain in their original folders on your 
computer.  

• People 
In this collection, you can organize your photos by what frequently matters most -- the 
people in them. Picasa uses facial recognition technology to find and group similar faces 



together across your entire collection of photos. By adding name tags to these groups of 
faces, new people albums are created. These people albums are just like the albums 
above: when you move or delete faces, the original files stay put.  

Edit your photos 

Picasa provides a range of one-click fixes to help you improve almost any photo, adjust its color 
and lighting, and add effects like black and white or sepia toning. Double-click a photo and use 
the three editing tabs on the left. 

Share your photos 

Your photos take on more meaning when you share them with friends and family. Here are two 
ways to quick share your photos: 

Upload photos to the web 
Use the Upload button in Picasa to upload all selected photos to Picasa Web Albums. Don't feel 
like picking through your photos? The Share button uploads an entire folder or album, and sends 
email invitations to your friends and family 

Email photos 

Click the Email button in Picasa to quickly send all selected photos to friends and family, using the 
email provider of your choice. Keep in mind that email doesn't accomodate a large number of 
photos, so if you want to share a lot of photos, consider uploading them to Picasa Web Albums, 
where you can take advantage of the free one GB of storage that's available. 

Discover more features 

If you've read this far, you're familiar with the basics of Picasa. As you become a 
power user, here are some of the features for you to explore: 

Resize photos: One of the most popular -- and most hidden -- features of Picasa is the ability to 
resize photos. Use the Export button to quickly resize your photos. 

Sync to Web: When you enable Sync to Web in Picasa for a folder or album, edits made to your 
photos in Picasa are reflected immediately in the corresponding album in Picasa Web Albums. 

Make a collage: Make a collage and share it with your friends and family. Experiment with six 
different types of collage, and maintain total control over your collage content and layout. 

Add captions: Adding captions can help tell the rest of the story. While editing a photo, click the 
text below that says 'Make a caption!'. Captions are displayed in Picasa, Picasa Web Albums, 
and other IPTC compatible programs. 

Use Movie Maker: Combine your photos, videos, and music into a movie and upload it directly 
to YouTube. You can also trim existing video files. 



Map photos: Use the Maps tab in Picasa to embed latitude and longitude information into the 
EXIF data of your photo file. This geographic data accompanies your photo when you upload it 
to Picasa Web Albums. 

Print photos: Use the Shop button to order prints from our online print partners or use the Print 
button to print your photos at home. 

Add tags: Tags are like keywords. By applying single or multiple-word tags in Picasa, you can 
quickly search and locate photos. The Tags tab offers quick tags, tag counts and the ability to 
manage your tags. 

Upload to Blogger: Use the BlogThis! button to post photos directly from Picasa to Blogger. 

Back up your collection: Protect those precious memories. Use Picasa to back up your photo 
collection to either an alternate drive or to CD/DVD. 

Revised 10/4/2010 JMM 

******************************************************* 

Forum re Picasa 3.  This will help you to understand what Picasa can and what it cannot do. 

Why, why did I trust you with my pictures??  Report 

abuse   
martian88  
Level 1 
2/9/10  

Before anyone downloads your program you need to state in GIANT letters that once you have control, 
we may never get them back. Even when we create backup disk, they'll only open on your Picasa!! I 
trusted you to store my pics, now I've lost most of them, never knowing if I deleted them from my 
documents to free up some space on my computer, you would delete them too. I ask you to help me get 
them back & you want even answer me!! Everyone needs to be warned NOT to trust you with their 
precious, irreplaceable pictures, I am mad, I am heartbroken!! I hate you!!!  

Best answers  

Don Lind  
Top Contributor 
2/26/10  

Popular answer Go to this answer  
This post title sure gets your attention... 
 
Yes, Martian...  Picasa is just another program on your computer.  
It finds your photos on your disk and lets you work with them.  
If you delete your photos (in Picasa or in Windows Explorer) they're deleted.  
Don't do that.  
 
@we-carey - a few comments... 
 
1. CDs and DVDs are (in my opinion and experience) way too painful to use as backups.  Sitting there 
with a Sharpie, feeding in blank DVDs for an hour is not my idea of fun.   And DVDs are just plain flakey.  
I had 20K photo backed up on DVDs and as a test (ALWAYS test your backups...) I found that about 25 
of the photos were unreadable on the backup.   That was my last backup to DVD.  External drive backups 
are much easier and better.    And much more reliable. 



 
2. Carbonite... be careful.  Several people used that and found that they didn't back up the right stuff.  
They lost all their album definitions because they didn't back up the Picasa Database stuff properly.  
That's the advantage of using Picasa's backup... it knows everything that needs to be backed up. 
 
3.  I'd suggest an external disk drive for backups...External USB disks are fast, cheap, and really nice.  
$80 or so gets you a 1TB external drive - room for 300,000 or so photos.   Picasa backs up to them very 
nicely.  
 
4.  I don't know what deleted your photos.   But from years of experience with Picasa directly and with 
many people in this forum, Picasa just plain doesn't randomly delete your photos.  It just doesn't happen.  
Someone has to have deleted the photos using Windows Explorer.  Or someone has to have deleted 
them using Picasa.  Or some other program.  Or, I guess a terrible disk error could wipe out photos, but it 
would be a very strange and selective error to zap just photos.  But just plain old using Picasa to 
organize, edit, and share photos doesn't delete your photos.  
 
5.  Hmmm... on the "albums vs. folders" thing... that is an absolutely critical concept in Picasa.  If you 
don't "get it," you're liable to delete all the photos in your folders.  Really.  That happens.    Folders are the 
real folders on your disk.  All your photos are in folders on your hard disk.  You can create albums in 
Picasa.  Albums exist ONLY in Picasa.  Albums look like folders (except albums have "blue book" icons 
rather than "Manila Folder" icons.  And, for many things, within Picasa, Albums act like folders.  But 
albums do not contain photos.   Albums simply "point to photos" that live in folders.  All too often, people 
create some albums.  And then they delete their folders... They're generally assuming that the albums 
have their own copies of the photos... and so, to save disk space, once they've got the albums set up, 
they delete the folders.   HUGE mistake.   Your real folders are in the folders.  They get deleted.  The 
albums then die because the photos they were "pointing to" are gone...   Never delete folders of photos 
unless you want them completely gone for good from everywhere.  Albums let you add organization to 
your photos.  Albums don't waste any space doing that...  

 

***************************************************************************** 
PDF File Creator 
 
FREE PDF file creator program 
 CutePDF - Create PDF for free, Free PDF Utilities, Edit PDF easily;. 

1. Download and install the program.   
2. Open a document, press PRINT. 
3. From the printer drop down menu  select 'cutepdf'.  
4. Save it as a .pdf file. 

******************************************************* 

Cute PDF 

Using CutePDF Writer to create PDF document: 

 DO NOT look for any application to run. Just print your document  using 

CutePDF Writer (the printer) to get PDF output. 

 1.    Open your original document and select Print command in File menu of your 
application to bring up Print dialog box. 

2.    Then select CutePDF Writer as the Printer to print (DO NOT select "Print to 
file" option). 

3.    You will get a Save As dialog box prompted for saving created PDF file.  



Select a folder to Save in and enter a File name, then click on Save. 

4.    Go to that folder to find your PDF file. 

   

* CutePDF Writer supports Microsoft Windows 98/ME/2000/XP/Vista/7 (x32/x64). 

* CutePDF Writer requires PS2PDF converter. You may get a free converter here. 

  

To uninstall CutePDF Writer: 

  Activate the Control Panel, double click Add/Remove Programs, and double click on 

the CutePDF Writer list box entry. 

 Or. 

 1.    On the Windows taskbar, click Start. 

2.    Run Programs -> CutePDF -> PDF Writer -> Uninstall CutePDF Writer. 

  

   

If you need more help, comments or bug reports... 

  Please visit World Wide Web at http://www.CutePDF.com. 

**************************************************** 

Convert word processor documents to PDF without paying hundreds of dollars for the full 
Adobe program. 

 

PrimoPDF  Totally Free PDF Creation  
  

Click here: Free PDF Converter - create high-quality PDF from any printable file type   

************************************************************************************************
**** 

PDF Reader Foxit 

 

The Adobe PDF program that is installed at the factory for nearly all PCs is a 50mb program.  

Foxit is a 5mb program that does the same thing, allows you to view .pdf files. 

 

  
Foxit can be downloaded Free at Click here: Foxit Software - Foxit Reader 3.0 for 

Windows.  The Foxit in the left column is the free program. 

***************************************************************************************** 

Make Your Own Personal Screen Saver In Win XP.  
 



1. Right click on the desktop, go to "Properties"  
2. Click the "Screen Saver" tab.  
3. Scroll down to My Pictures Slideshow. 
  

4.Click the "Settings" button and make the specific adjustments, such as 
picture size, transition effects and etc. 
 

5. Click "Browse" to find the folder where the particular images or photos are 
stored. If there are some pictures within that folder that you do NOT want to use 
in the Slideshow screensaver, you may wish to create a New Folder and add 
only those pictures that you wish to be shown. 
  

6. After selecting the folder that contains only those pictures for the screen 
saver slideshow, click  "OK" . 
If you want to have a look into the preview click "Preview" and see what 
happens. 
  

7. In the WAIT: box enter the time when the screen saver should begin. 
8.  Click Apply and Ok.  
 

************************************************************************************** 

Screen Saver Fix in XP 

This issue might occur due to sleep mode option timing is set to a shorter period than 
the screen saver timing that is causing the PC to directly going to sleep instead of to 
screen saver mode. Therefore, to isolate and resolve the issue, I recommend you to 
perform the steps provided below: 

1. Right-click the desktop background, and select Properties. 
2. Select Screen Saver tab. 
3. Select the screen saver to be used from the screen saver menu list. 
4. Select the number of minutes to WAIT until screen saver activates.  
5. Click Apply and OK. 
6. Click Power to go to the Power Management screen.  
7. In the Power Options window, next to 'Turn off the Display', dropdown to a time that 
you want that is greater than the Screen Saver wait time or set to Never. 
8. Also, next to 'Put the Computer to Sleep', dropdown to a time that you want that is 
greater than the Screen Saver wait time or set to Never. 
9. Save the changes and close all the windows. 

This will disable the sleep mode time to increase and let the screen saver  work 
properly. 



************************************************************************************ 

Save System Information  using BELARC ADVISOR.  
  

 You can download a the free program at http://www.belarc.com/free_download.html    
When you run this software, it will take a snapshot of your system and display a Web page 
providing a complete summary.  The data resides on your local system and is not sent to a Web 
server.   The report provides information on all hardware and software you are  
running.  It even tells you the version number.  And it's all free, for personal use, and supports 
Windows 95/98/ME/NT4/2000/XP. 
 
Revised 4/5/2013 

 
Info from Belarc 
 
It's best to get the latest version of the Advisor from 
  http://www.belarc.com/free_download.html  
  
 
If you are finding that your browser is not showing your PC's Belarc Advisor profile please try the 
following steps: 
 
1.  Open Internet Explorer 
2.  Select File>Open 
3.  Select Browse, then navigate to the following directory: 
 
          c:\program files\belarc\advisor\system\tmp 
 
4.  In this directory you will find a file named like (computer_name).html.  Please highlight this file and 
select Open. 
 
When you don't see your PC's profile, that's caused by Windows being mis-configured so that it doesn't 
use your web browser to open files with the .html file extension.  This usually happens when you switch 
the web browser you use, or install an application that helps view or edit web content.  You can fix this 
in the Folder Options Control Panel.  On the File Types tab, select the HTML extension and click the 

Change... button to set your browser to be used for HTML files.  

  

JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 



place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  
 


